
Pepper 使用说明

1



2

准备好探索你的新机器人!

主要内容:

- 机器人拆箱
- 硬件介绍
- 启动与配置
- 应用商店
- 基本交互
- 软件介绍
- 机器人装箱

欢迎!
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机器人拆箱

第一步



机器人拆箱

1) 将箱子竖立起来 2) 打开箱子并移除盖板
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短期存储方式



机器人拆箱

3) 向外翻出底部斜板 4) 将头和手臂拨出
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机器人拆箱

5) 将双手放到Pepper的腋下, 然后将Pepper从

箱子中抬出来
6) 将Pepper摆放成休息的姿势。如果处于错
误的姿势，将导致Pepper站不稳或者摔倒。
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7) 移除腰部和膝盖处的插销 8) 打开Pepper颈部后面的软盖，将插销按位置存放妥当
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机器人拆箱



机器人拆箱

9) 解锁紧急制动按钮 10) 取出充电器
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机器人拆箱

剩下的东西:

- 平板的保护罩

- 充电器盒子

将这些存放在箱子中，你需要这些来存放或运送Pepper

恭喜你！你的机器人已经准备好了！
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姿势

休眠(Rest): 安全姿势

- 头朝下

- 膝盖和臀部弯曲

以下情况下使用:

- 电机关闭

- 休息模式

- Pepper关机状态

站立(Standing): 工作姿势

- 站立,

双手置于身体两侧
- Pepper已经唤醒，可

以使用
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硬件介绍（基于1.8a/1.8）



Pepper外形尺寸
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硬件介绍



Pepper组成结构
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硬件介绍



14

硬件介绍



传感器
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硬件介绍



传感器
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硬件介绍

头顶处触摸传感器（三个）：Doc

手背处触摸传感器（双手各一个）：Doc

http://doc.aldebaran.com/2-5/family/pepper_technical/contact-sensors_pep.html#ju-head-tactile-sensor
http://doc.aldebaran.com/2-5/family/pepper_technical/contact-sensors_pep.html#ju-tactile-hands


传感器
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硬件介绍

麦克风：头顶网罩下面（4个）Doc

http://doc.aldebaran.com/2-5/family/pepper_technical/microphone_pep.html


传感器
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硬件介绍

2D摄像头：额头/嘴巴处 各一个

3D摄像头：左眼处 一个

Doc

http://doc.aldebaran.com/2-5/family/pepper_technical/video_overview.html


传感器
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硬件介绍

碰撞传感器：左、右、后侧 各一个 Doc

http://doc.aldebaran.com/2-5/family/pepper_technical/contact-sensors_pep.html


传感器
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硬件介绍

声纳：前后各一个 Doc

http://doc.aldebaran.com/2-5/family/pepper_technical/sonar_pep.html


传感器
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硬件介绍

激光传感器：前、左、右各一个 Doc

http://doc.aldebaran.com/2-5/family/pepper_technical/laser_pep.html


传感器
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硬件介绍

激光发射器：前、左、右各一个 Doc

http://doc.aldebaran.com/2-5/family/pepper_technical/laser_pep.html


传感器
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硬件介绍

红外传感器：左、右 各一个 Doc

http://doc.aldebaran.com/2-5/family/pepper_technical/irspot_pep.html


硬件介绍

执行器

Yaw

Roll

Pitch

根据关节和方向来命名电机:
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硬件介绍

按钮

电源按钮：胸口

25

紧急制动按钮：软盖里面



硬件介绍

制动器和插销

Pepper的臀部和膝盖处都有制动器。它们可以防止Pepper摔倒

使用插针松开制动器的几种情况：
- 将Pepper放在盒子中

- 手动设置Pepper姿势时

- 搬运Pepper时
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硬件介绍

平板电脑

1、光线传感器

2、前置摄像头

3、麦克风

4、SD卡卡槽

5、耳机插孔
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硬件介绍

平板电脑

1、IMEI标签

2、WIFI & BT MAC 地址

3、认证标签

4、Home键

5、返回键

6、Recent键
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7、FCC标签

8、SD卡卡槽

9、扬声器



充电口盖

机器人充电

打开充电口盖给Pepper充电.  

安全事项：

当充电口盖抬起时, Pepper的轮子将不会自主驱动.

技巧：如果你不想Pepper到处走，又能正常使

用，可以将充电口盖抬起.

充电时间：

● 约3.5小时充到80%

● 约8小时充到100%

● 当充满电时，充电器LED变为绿色，状态
LED呈绿色闪烁。
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硬件介绍

充电插头

咔！



硬件介绍

移动你的机器人

- 回复到休息姿势

- 确保充电口盖已抬起

- 抓紧机器人
- 一只手放在Pepper的肩上

- 一只手放在Pepper的臀部

- 小心的移动Pepper
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硬件介绍

胸部按钮

胸部按钮的多种用途:

- 当Pepper关机状态时:

- 按一下:    启动Pepper

- 长按(5秒):   检查微控制器并启动Pepper

- 当Pepper开机状态时:

- 按一下: 获得当前的状态和警告/错误信息（如有）

- 连续按压两次: 休眠 / 唤醒（交替）

- 按压持续3秒: 将Pepper关机（伴随关机音）

- 按压持续8秒: 将Pepper强制关机（Pepper立即断电，注意
当前姿势，防止摔倒）
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硬件介绍

网络连接方式

- 无线网连接

- 以太网连接.

使用(臀部的)插销插入头部后盖下方的两个孔位，打开头部后盖就可
以看到以太网接口。
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启动与配置



启动Pepper

按平板下方的胸部按钮一下来开机 在开机过程中:
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- 肩部的LED灯缓慢的闪烁

- 耳朵上的LED灯作为开机的进度条

整个启动过程大约需要3分钟

当Pepper说：

“OGNAK GNOUK”

这表示Pepper已经开机!

开机完成后，Pepper将会根据预装APP或设置的不同，出现不
同的运行状态。如果Pepper未安装任何APP并第一次开机时，
平板上会出现初始化设置页面。此时需要用户完成各项设置之
后，Pepper才能启动完毕。



配置Pepper

当你第一次启动机器人的时候，平板电脑上会出现一个入门向导，触摸屏幕以启动
向导，然后完成所有建议的步骤。
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配置Pepper

选择一种语言，然后单击下一步按钮。
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配置Pepper

检查并验证最终用户软件许可协议的2个条件，然后单击下一步按钮。
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配置Pepper

选择一个可用的WiFi网络，并完成所需的参数。
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配置Pepper

连接WiFi后，将显示黄色星形。
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配置Pepper

选择一个时区，然后单击下一步按钮。
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配置Pepper

定义密码以保护对Pepper的远程访问（建议密码设置为nao，也可以设置为其他
密码，但是一定要记住！），然后单击下一步按钮。

41



配置Pepper

自定义Pepper的名称，如果您有多个Pepper，这将非常有用。然后单击下一步
按钮。
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配置Pepper

输入您的Aldebaran用户社区帐户的登录名和密码账号申请，此后，您将能够从
Store检索应用程序和服务。然后单击下一步按钮。
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https://store.aldebaran.com/default/customer/account/create/
http://doc.aldebaran.com/2-5/family/pepper_user_guide/store_home_pep.html#store-pep


配置Pepper

检查并验证自动诊断报告，然后单击下一步按钮。
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配置Pepper

应用程序更新，单击“全部更新”按钮，然后单击下一步按钮。
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配置Pepper

系统升级，单击“立即更新”按钮，如有必要，消息会提示您确保插入电池充电
器。
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配置Pepper

出现以下屏幕时，配置完成：
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应用商店



访问商店

在连接到互联网的计算机上，单击或键入：https://store.aldebaran.com/

单击 Sign in 按钮，将显示 Login or create an account 页面。输入您的电子
邮件和密码，点击登录。
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https://store.aldebaran.com/


选择要安装的应用程序

1.在商店中，选择Applications / Pepper。
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选择要安装的应用程序

2.单击要安装的应用程序。

3.单击复选框以接受应用程序的使用条款。

4.单击 Install 按钮。
该应用程序将在下一次机器人更新时安装。
有关详细信息，请参阅：Pepper 设置
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基本交互
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基本交互

在你的机器人上, 我们 (有可能) 已经安装了一系列特殊的软件来让你试着跟

Pepper进行交互:

- 当Pepper看到有人靠近他时， “The Dialog” 这个App会自动启动。

这个App会触发一些“对话主题”，使你能够跟机器人交流。

- Basic channel : 这是一系列“对话主题” （内容库）

如果没有从在线平台上下载过这些
APP，Pepper将不具备这个功能。
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基本感知

当你的机器人启动后，她会站起来并且开始寻找附近的人
这就是所谓的基本感知
Pepper 现在能够对基本刺激作出反应:

- 声音

- 移动物体

- 触觉

- 人

目的就是为了能够找到人，并且和人进行交互!



和Pepper对话

交互区域

28

区域 3 (Zone 3)
你离得太远了，Pepper能看见你，
但你们互相之间听不见。

各区域的距离可以进行设定。
默认距离：

区域1: 0 - 1.5m

区域2: 1.5 - 2.5m

区域3: >2.5m

Doc

区域 2 (Zone 2)
你离得有点远了，但你可以听到她
叫你。

区域 1 (Zone 1)
你离Pepper够近了，可以跟他对
话了。

http://doc.aldebaran.com/2-5/naoqi/peopleperception/alengagementzones.html#alengagementzones


和Pepper对话
眼睛可以告诉你...

粉红色: 蓝色 (旋转): 绿色:

跟踪到一个人 正在听 思考中
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和Pepper对话

我可以跟Pepper说什么? (如果装了Basic Channel)

你的名字是什么? 你好吗?

你会做什么? 你的IP地址是什么?

现在几点? 举起你的手臂.

你有多高? 你体重多少?

你几岁了? 你是男孩还是女孩?

你是什么颜色? 为什么你的名字叫Pepper?

你有家人吗? 你是什么颜色?



休眠 / 唤醒

→ 连按两次胸部按钮

休眠

按!  
按!

唤醒
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关闭你的机器人

- 长按胸部按钮3秒, 直到机器人说“GNUK GNUK”

- 机器人会进入“休眠”姿势

- 这个过程大概30秒
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Pepper 设置



Pepper 设置

Pepper启动之后, 你可以使用机器人网页进行设置.

1) 按一下胸部按钮，Pepper会说出他的IP地址。

2) 在浏览器中输入IP地址。

3) 你会被要求提供密码(用户名是 nao, 默认密码是 nao ), 然后你就可以访问

设置页面了。
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Pepper 设置

我的机器人
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显示并设置机器人的基本设置。

网络设置 设置网络连接

更新 获取应用更新，设置和管理您的云帐户。

高级设置 显示并设置机器人的高级设置。



Pepper 设置

“advanced” 页面可以看到更多细节。
- 在浏览器输入http://机器人的IP地址/advanced

- 在这里你可以找到一些重要的信息，比如序列号。(头部 ID  和身体 ID).

- 不同的页面使您能够访问有关硬件、软件的详细信息。
36
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软件



65

软件 – 在机器人上的...

两个设备: 头部和平板电脑, 通过以太网连接(USB)

- 头部:
- 运行Linux系统

- 执行程序

- 存储数据

- 连接到互联网

- 为平板电脑提供应用程序网页

- 平板电脑:
- 运行Android系统

- 在浏览器中显示应用程序中网页、图像、视频

- 连接到互联网



软件 – 在机器人上的...

操作系统： NAOqi

NAOqi 和服务(Service)一起工作:

66
（应用程序(APP)将调用NAOqi的接口来让机器人工作。）



软件 – 在电脑上的（开发工具）…

Choregraphe
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简易可视化编程工具

Android Studio

谷歌推出的一个Android集成开
发工具，基于IntelliJ IDEA

Software Development Kit

提供给C++ 或者 Python
的综合API



软件 - Choregraphe
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软件 - Choregraphe

轻松创建动画、简单行为和对话。

在一个模拟机器人上、或者直接在一个真实的机器人上运
行程序，同时可以监控和控制你的机器人。

打包并部署（安装）应用程序至机器人本地。



软件 - Choregraphe

一个应用程序(APP)包含什么?

- 行为 (.xar):    Pepper能做什么

- 对话主题 (.dlg / .top):    Pepper可以谈论什么

- 其他资源(媒体, 脚本, 网页…)

- 属性 (图标, 名字, …)
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指令盒 (Choregraphe编程的基本组件)

开始输入口
停止输入口

停止输出口
非停止输出口

“激活”: 仅激活

71

“数字”: 激活 + 数据传递（数字）

“字符串”: 激活 + 数据传递（字符串）

“动态”: 激活 + 数据传递（动态数据）

软件 - Choregraphe
指令盒
输入输出口

指令盒间的流程：

可以触发，同时可以传递数据



试试编写
第一个App…

Hello world!

2. 然后拖到这里…

1. 找到 “Say” → 3. … 点击运行!
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软件 - Choregraphe



运行App

→ 所有单次运行的app都有一个统一的名字 “.lastUploadedChoregrapheBehavior”

（临时文件，不保存。）

如果需要保存并安装

到机器人身上:

73

软件 - Choregraphe



如果想要导出pkg文件包!  （APP安装包）

注意: 填写属性栏各项属性:

Application:

● Name

● ID

● Description…  

Behaviors:

● Name

● Triggersentences  

Dialogs:

● Availability from autonomous life
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软件 - Choregraphe
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软件 – Android Studio

要求

Android Studio
版本2.3或更高版本
我们建议安装最新的稳定版本。

Java开发工具包（JDK） Android Studio的系统要求

要安装Android Studio，请按照此处提供的安装指南进行操作：
http： //developer.android.com/sdk/index.html

http://developer.android.com/sdk/index.html
http://developer.android.com/sdk/index.html
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软件 – Android Studio

要开发Android应用程序，您需要安装Android SDK及其Build-Tools：

1.打开Android Studio:
⚫ 选择工具 > SDK Manager或
⚫ 单击 SDK Manager按钮。

https://android.aldebaran.com/sdk/doc/pepper-sdk/_images/sdk_manager_win.png
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软件 – Android Studio

要开发Android应用程序，您需要安装Android SDK及其Build-Tools：

2.下载并安装Android SDK 6.0版
（API 23，Marshmallow）。

https://android.aldebaran.com/sdk/doc/pepper-sdk/_images/android_sdk_install.png
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软件 – Android Studio

要开发Android应用程序，您需要安装Android SDK及其Build-Tools：

3.下载并安装SDK Build-Tools

还需要SDK构建工具，例如Emulator 
/ Android Debug Bridge。下载并安
装与安装的Android SDK相同版本的
SDK Build-tools。

注意：获取机器人SDK和工具部分中描述
了Android虚拟设备（AVD）环境的系统
映像。
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软件 – Android Studio

获取Pepper SDK插件

⚫ 从Android Studio中选择
“ File” > “Settings”。

⚫ 选择 Plugins 子菜单。
单击“ Browse repositories”按
钮。Android Studio会在线显示
一长串插件。
⚫ 在搜索栏中输入“Pepper”，
以便找到Pepper SDK。

https://android.aldebaran.com/sdk/doc/pepper-sdk/_images/plugins_step1.png
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软件 – Android Studio

选择Pepper SDK并单击Install plugin按钮。

安装后重启重启Android 
Studio。

https://android.aldebaran.com/sdk/doc/pepper-sdk/_images/plugins_step2.png
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软件 – Android Studio

检查结果：浏览Android Studio的菜单，您应该看到以下选项：

⚫ File > New > Robot Application
⚫ Tools > Pepper SDK > Robot SDK 

Manager
⚫ Robot SDK Manager         也应出
现在工具栏中。如果看不到，选
择 View > Toolbar 并确保选中它

https://android.aldebaran.com/sdk/doc/pepper-sdk/_images/plugins_step3.png
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软件 – Android Studio

获取机器人SDK和工具

1.在Android Studio里面
⚫ 选择Tools > Pepper SDK > Robot 

SDK Manager或
⚫ 检查要开发机器人应用程序的目
标API版本，然后单击Apply按
钮。
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软件 – Android Studio

机器人SDK内容

AVD
（Android虚拟设备）：
AVD系统图像与机器人平板电脑图像相同。提供x86和armeabi架构。

工具
机器人模拟器和用于开发机器人应用程序的工具，例如Robot 

Viewer, Robots Browser, Trajectory等。

你准备好了！
现在是创建机器人应用程序的时候了。

https://android.aldebaran.com/sdk/doc/pepper-sdk/ch1_gettingstarted/starting_project.html#creating-robot-app
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你可以在机器人上用哪些软件呢？

- 访问文件系统文件：SFTP

- 访问终端：SSH

当你在机器人上工作时，机器人头部处理你的所有命令

- 录音存储在头部
- 日志存储在头部

软件 - 其他



测试 : 拍照

用SFTP工具连接到机器人，并查看“recordings”文件夹下的文件

Host: IP Address  （

机器人联网ip）

Username: nao

Password: Robot Password (default nao)  

Port: 22
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软件 - 文件系统
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现在让我们使用SSH访问机器人的头部！

工具：“putty” （Windows系统）
“ssh”命令行工具（Linux / Mac系统）

用账号密码登录，默认都是 nao

ssh nao@<IP-of-robot>

默认密码：nao  

测试:

pepper [0] ~ $ [type here:] say hello

软件 - SSH
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NAOqi有一个非常好的命令行工具 “qicli”

使您能够访问机器人中可用的所有服务Service，方法Method或信号Signal，

您将在代码中使用这些服务，方法或信号。

示例:   （通过直接调用api拍一张照片）

qicli call ALPhotoCapture.takePicture “/home/nao” “photo.jpg”

...然后可以找到那个相关的图片文件

软件 - SSH
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完成测试:

qicli info (列出所有载入的服务模块)  

qicli info ALSystem (列出ALSystem中所有函数)  

qicli call ALSystem.shutdown  (调用ALSystem中shutdown函数)

软件 - SSH
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机器人装箱



重新装箱机器人

1) 按下紧急停止按钮（确保关机） 2) 垂直放置箱子，打开箱子，

翻开坡道
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重新装箱机器人

3) 将Pepper的插销在如图所示的地方插上 4) 从腋下抓住Pepper，并将其移动到箱内
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重新装箱机器人

5) 将箱子连同机器人缓缓放倒 6) 确保头部和手部完全入位
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重新装箱你的机器人

7) 放置平板电脑的保护泡沫 8) 放置充电器盒子，盖上盖子！
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恭喜你，完成新手引导


